
Evaluates: MAX11270MAX1127X Family Evaluation Kit

General Description
The evaluation kit (EV kit) demonstrates the MAX1127X 
family of 24-bit, 64ksps delta-sigma ADCs with integrated 
PGA. The EV kit includes a graphical user interface (GUI) 
that provides communication from the target device to the 
PC. The EV kit can operate in multiple modes:
1) Standalone Mode: In “Standalone” mode, the EV 

kit is connected to the PC through a USB cable and 
performs a subset of the complete EV kit functions 
with limitation for sample rate and size.

2) FPGA Mode: In “FPGA” mode, the EV kit is con-
nected to an Avnet ZedBoard™ through a low-pin-
count FMC connector. ZedBoard features a Xilinx® 
Zynq®-7000 SoC that connects to the PC through an 
Ethernet port, which allows the GUI to perform differ-
ent operations with full control over mezzanine card 
functions. The EV kit with FPGA platform performs 
the complete suite of evaluation tests for the target IC

3) User-Supplied SPI Mode: In addition to the USB 
and FMC interfaces, the EV kit provides two 12-pin 
PMOD-style headers for user-supplied SPI interface, 
to connect the signals for RDYB, SCLK, DIN, DOUT, 
and CSB.

The EV kit includes Windows XP®-, Windows® 7 and 
Windows 8.1-compatible software to exercise the features 
of the IC. The EV kit GUI allows different sample sizes, 
adjustable sampling rates, on-board or external reference 
options, and graphing software that includes the FFT and 
histogram of the sampled signals with the ability to save 
plots in .jpg or .csv formats. 
The ZedBoard board accepts a +12V AC-DC wall adapter. 
The EV kit can be powered by the ZedBoard or by a local 
12V supply. The EV kit has on-board transformers and 
digital isolators to separate the IC from the ZedBoard/
on-board processor. 
The MAX11270 EV kit comes installed with a 
MAX11270EUG+ in a 24-pin TSSOP package.

Features and Benefits
 ● High-Speed USB, FMC Connector, and PMOD 

Connector
 ● 5MHz SPI Interface
 ● Various Sample Sizes and Sample Rates
 ● Collects Up to 1 Million Samples (with FPGA Platform)
 ● Time Domain, Frequency Domain, and Histogram 

Plotting
 ● Save Plots as jpg, bmp or csv
 ● Sync In and Sync Out for Coherent Sampling 

(with FPGA Platform)
 ● On-Board DAC (MAX542) for DC Signal-Level 

Generation 
 ● On-Board Voltage Reference (MAX6126)
 ● Proven PCB Layout
 ● Fully Assembled and Tested
 ● Windows XP-, Windows 7-, and Windows 

8.1-Compatible Software
 ● Savable ADC Configurations

19-7592; Rev 0; 4/15

Ordering Information appears at end of data sheet.

ZedBoard is a trademark of Avnet, Inc.
Xilinx and Zynq are registered trademarks and Xilinx is a regis-
tered service mark of Xilinx, Inc.
Windows and Windows XP are registered trademarks and reg-
istered service marks of Microsoft Corporation.
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Quick Start
Required Equipment

 ● MAX11270 EV kit
 ● +12V (500mA) power supply
 ● Micro-USB cable 
 ● ZedBoard development board (optional – Not Included 

with EV kit)
 ● Function generator (optional)
 ● Windows XP, Windows 7, or Windows 8.1 PC with a 

spare USB port
Note: In the following sections, software-related items are 
identified by bolding. Text in bold refers to items directly 
from the EV system software. Text in bold and underline 
refers to items from the Windows operating system. 

Procedure
The EV kit is fully assembled and tested. Follow the steps 
below to verify board operation:
1) Visit www.maximintegrated.com/evkitsoftware to 

download the latest version of the EV kit software, 
MAX11270EVK.ZIP. Save the EV kit software to a 
temporary folder and uncompress the ZIP file.

2) Install  the EV kit software and USB driver on your com-
puter by running the MAX11270EVKitSetupV1.1.exe 
program inside the temporary folder. The program 
files are copied to your PC and icons are created in 
the Windows Start | Programs menu. At the end of 
the installation process, the installer will launch the 
installer for the FTDIChip CDM drivers.
For Standalone mode:

3) Verify that all jumpers are in their default positions for 
the EV kit (Table 2).

4) Connect the PC to the EV kit using a micro-USB 
cable.

5) Connect the +12V adapter to the EV kit.
6) Start the EV kit software by opening its icon in the 

Start | Programs menu. The EV kit software appears 
as shown in Figure 1. Verify that the lower left status 
bar indicates the EV kit hardware is Connected.

7) From the Device menu, select Standalone and click 
Search for USB Device. Then select Standalone 
again and select a device in the list. Verify that the 
lower left status bar indicates the EV kit hardware is 
Connected.
For FPGA mode (when connected to a ZedBoard):

8) Connect the Ethernet cable from the PC to the 
ZedBoard and configure the Internet Protocol Version 
4 (TCP/Ipv4) properties in the local area connec-
tion to IP address 192.168.1.2 and subnet Mask to 
255.255.255.0.

9) Verify that the ZedBoard SD card contains the  
boot.bin file for the MAX11270 EV kit.

10) Connect the EV kit FMC connector to the ZedBoard 
FMC connector. Gently press them together.

11) Verify that all jumpers are in their default positions for 
the ZedBoard (Table 1) and EV kit (Table 2).

12) Connect the 12V wall adapter power supply to the 
ZedBoard. Leave the ZedBoard powered off. Connect 
the PC to the ZedBoard with an Ethernet cable.

13) Enable the power supply by sliding SW8 to ON. 
14) Start the EV kit software by opening its icon in the 

Start | Programs menu. The EV kit software appears 
as shown in Figure 1. From the Device menu, select 
FPGA. Verify that the lower left status bar indicates 
the EV kit hardware is Connected. 
For either Standalone or FPGA mode:

15) Connect the positive terminal of the function generator 
to the IN+ test point on the EV kit. Connect the nega-
tive terminal of the function generator to the IN- test 
point on the EV kit. Disable the function generator. 

16) Enable the function generator. Configure the signal 
source to generate a 1kHz, 1VP-P sinusoidal wave 
with +500mV offset. 

17) In the Calibration group, select Self Offset/Gain in 
the drop-down list and then click Calibrate. 

18) Click on the Scope tab. 
19) Check the Remove DC checkbox to remove the DC 

component of the sampled data.
20) Click the Capture button to read sampled data from 

the ADC. 
21) The EV kit software appears as shown in Figure 4. 
22) Verify the frequency is approximately 1kHz displayed 

on the right. The scope graph has buttons in the 
upper-right corner that allow zooming in to detail.

FILE DECRIPTION

MAX11270EVKitSetupV1.1.exe Application Program 
(GUI)

Boot.bin ZedBoard Firmware 
(SD Card to boot Zynq)

MAX11270 EV Kit Files

www.maximintegrated.com/evkitsoftware
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Table 1. ZedBoard Jumper Settings (Optional)

Table 2. MAX1127X EV Kit User Configuration Jumper Settings*

JUMPER SHUNT 
POSITION DESCRIPTION

J18 1-2 VDDIO set for 3.3V
JP11 2-3

Boot from SD card

JP10 1-2
JP9 1-2
JP8 2-3
JP7 2-3

JP10 —
J12 — SD card installed
J20 — Connected to 12V wall adapter
SW8 Off ZedBoard power switch, off while connecting boards

JUMPER SHUNT 
POSITION DESCRIPTION

J2 (Red)
1-2 Connects the +10V rail to test point +10VEXT for external power (op amp + supply)
2-3* Connects the +10V rail to LDO U2 (op amp + supply) 

J3 (Red)
1-2 Connects the +15V rail to test point +15EXT for external power (powers U2)
2-3* Connects the +15V rail to isolation transformer (powers U2)

J4 (Red)
1-2 Set ADC DVDD to +3.3V
2-3* Set ADC DVDD to +2.0V

J5 (Red)
1-2* Connect ADC AVSS to GND (unipolar mode – also set J8 for unipolar)
2-3 Connect ADC AVSS to -1.8V (bipolar mode – also set J8 for bipolar)

J6 (Black)
1-2 Apply an offset of ADC_REFP (2.5V default) to amplifier U24
2-3 Apply an offset of 2.5V to amplifier U24

Open* No offset for amplifier U24

J7 (Black)
1-2 Apply an offset of ADC_REFP (2.5V default) to amplifier U27
2-3 Apply an offset of 2.5V to amplifier U27

Open* No offset for amplifier U27

J8 (Red)
1-2 Connect ADC AVDD to +1.8V (bipolar mode)
2-3* Connect ADC AVDD to 3.6V (unipolar mode)

J15 (Red)
1-2* Connects ZedBoard +12V to main power supply (U3). Diode D2 protects supplies.

Open Disconnects ZedBoard +12V from main power supply

J17 (Red)
1-2 Connects U5 input to GND
3-4 Connects U5 input to test point -15VEXT for external power
5-6* Connects U5 input to isolation transformer

J18 (Red)
1-2 Do not connect
3-4 Do not connect
5-6 Connects U5 output to GND, which sets the reference for the -10V supply (op amp - supply)

J20 (Red)
1-2* Connects on-board FTDI chip to 3.3V, necessary for standalone mode

Open Disconnects on-board FTDI chip power. This jumper does not interfere with the ZedBoard.

J21 (Black)
1-2* Drive ADC REFP pin with on-board voltage reference
2-3 Drive ADC REFP pin with external voltage reference
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Table 2. MAX1127X EV Kit User Configuration Jumper Settings* (continued)

JUMPER SHUNT 
POSITION DESCRIPTION

J22 (Black)
1-2 Ground test point CH_D- 
3-4 Ground test point CH_D+

J23 (Black)
1-2* Drive ADC REFN pin with on-board voltage reference
2-3 Drive ADC REFN pin with external voltage reference

J24 (Black)
1-2 Ground test point CH_C- 
3-4 Ground test point CH_C+

J25 (Black)

1-2* Connect output of U23 (CH_C) to U24 inverting input
3-4 Connect CH_D- to U24 inverting input
5-6 Connect output of U23 (CH_C) to U24 noninverting input
7-8 Connect CH_D+ to U24 noninverting input

J26, J27 
(Black)

1-2* Set both jumpers to align with silkscreen text “EXT” to drive ADC_INP and ADC_INN with  
test points IN+ and IN- (also external connector J10 is on same net)

3-4 Set both jumpers to align with silkscreen text “AMP” to drive ADC_INP and ADC_INN with U27 and 
U24 amplifiers

5-6 Set both jumpers to align with silkscreen text “DAC” to drive ADC_INP and ADC_INN with DAC_
OUT+ and DAC_OUT- 

7-8 Set both jumpers to align with silkscreen text “REF” to drive ADC_INP and ADC_INN with ADC_
REFP and ADC_REFN voltage reference

9-10 Ground ADC_INP and INN

J28 (Black)
1-2 Ground test point CH_A- 
3-4 Ground test point CH_A+

J29 (Black)

1-2* Connect output of U26 (CH_A) to U27 inverting input
3-4 Connect CH_B- to U27 inverting input
5-6 Connect output of U26 (CH_A) to U27 noninverting input
7-8 Connect CH_B+ to U27 noninverting input

J30 (Black)
1-2 Ground test point CH_B- 
3-4 Ground test point CH_B+

J36 (Black)
1-2 Drive ADC CLK pin with signal from SMA connector J34
2-3* Drive ADC CLK pin with signal from on-board oscillator U20 

J37 (Red)
1-2* Connect ADC to the DVDD voltage selection jumper J4
open Attach amp meter between pins 1-2 to measure current consumed by ADC DVDD

J40 (Black)
1-2* Connect ADC RST to DVDD (normal operation)
2-3 Connect ADC RST to GND (reset state)

J44 (Black)
1-2* Sets U18 noninverting input to 0V. Gain = -1 with offset = 0. Drives DAC_OUT-.
2-3 Sets U18 noninverting input to 2.5V. Gain = -1 with offset = 2.5V. Drives DAC_OUT-.

J45 (Black)
1-2* Sets U17 noninverting input to 0V. Gain = -1 with offset = 0. Drives DAC_OUT+.
2-3 Sets U17 noninverting input to 2.5V. Gain = -1 with offset = 2.5V. Drives DAC_OUT+. 

J46 (Red)
1-2* Enables main power supply (U3)

Open Disables main power supply (U3)
*Red test points and red jumpers are used for power settings.
Black test points are used for ground points.
White test points are used for all signal points, black jumpers for signal settings.
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General Description of Software
The main window of the EV kit software contains sev-
eral tabs: ADC Config, DAC Config, Function Generator, 
Scope, DMM, Histogram, FFT, and ADC Registers. The 
ADC Config tab and ADC Registers tab provide control 
to communicate with the MAX1127X registers. The DAC 
Config tab and Function Generator tab provide control to 
communicate with the MAX542. The other four tabs are 
used for evaluating the sample data read from the ADC.

ADC Config Tab
The ADC Config tab provides an interface for configur-
ing the IC from a functional perspective. The main block 
provides for calibration, GPIO control, input path selec-
tion, data format, filtering, power, and clocking. To read 
all the configuration settings, click the Read All button in 

the Serial Interface block. When a setting is changed, 
the register associated with that setting is automatically 
written. The Status Log at the bottom of the GUI shows 
the value and register that was changed.
The primary mode for calibration is using the drop-down 
list to select a calibration mode, followed by clicking the 
Calibrate button. The checkboxes for Self Offset, Self 
Gain, System Offset, and System Gain allow for the 
user to enable or disable the calibration values. The cali-
bration values can also be changed manually by entering 
a hex value in the SPI numeric box.
The Power block allows the user to put the part in a 
power-down or standby state by selecting one of these 
options in the drop-down list. The configuration set-
tings can be reset back to default by clicking the Reset 

Table 3. MAX1127X EV Kit User Off-Board Connectors
CONNECTOR 
REFERENCE 
DESIGNATOR

DESCRIPTION

J1 USB connector for standalone mode

J9 External reference input for EXT_REFP and EXT_REFN

J10 External input for ADC IN+ and IN-

J12, J16 External power connections, 12V. Both wall adapter and screw terminals are provided. When ZedBoard is 
used, these connectors are not necessary if jumper J15 is installed.

J13 External connections for AVDD and AVSS

J14 External enable, driven by GPIO1 via FET

J19 Serial EEPROM signal

J31 Sync clock input, SMA

J32 PMOD A, connects to ADC, 12-pin connector

J33 PMOD B, connects to DAC, 12-pin connector

J34 External clock input, SMA

J35 DAC SPI port signal

J38, J41 Sync clock out, SMA

J39 ADC SPI port signal

J42 Split sync clock in, SMA

J43 FMC connector for use with ZedBoard
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Registers button. For the Clock source selection, the IC 
internal clock is always a valid option. If the external clock 
is selected, a clock must be applied at the IC CLK pin by 
setting jumper J36 to either SMA or OSC. Once the above 
configurations are completed, start conversion by clicking 
Convert in the Serial Interface block. To read the data 
and status, click Read Data and Status on the lower right 
of the GUI.

To save a configuration, select Save ADC Config As… 
in the File menu. This saves all the ADC register values 
to an XML file. To load a configuration, select Load ADC 
Config in the File menu. When the XML file is loaded, all 
the register values in the file are written to the ADC.

Figure 1. MAX1127X EV Kit Software (ADC Config Tab)
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DAC Config Tab
In standalone mode, the ADC and DAC cannot oper-
ate concurrently. It is recommended to use FPGA 
mode when using the DAC for function generation. 
The DAC Config tab sheet provides an interface for 
configuring the MAX542 to drive the DAC_OUT+ and  
DAC_OUT- pins. Set J45 Offset and J44 Offset to match 
the jumper positions on the EV Kit. These jumper posi-
tions apply DC offset to DAC_OUT+ and DAC_OUT-, 
see the DAC amplifier section for more details. To write a 
value to the DAC, select the output of interest in the drop-
down list, enter a value in the numeric box and then click 
DAC Single Shot. The outputs on the right display the 
voltage outputs and the decimal code written to the DAC. 

The voltage outputs are calculated based on the DAC 
code and jumper offsets. 
The Calibration section of the DAC Config tab can be 
used to calibrate the calculated voltages to be closer to 
the measured voltages. Select which output to calibrate 
with the radio buttons. Enter the maximum and minimum 
voltage for this output in the Ideal (V) numeric boxes. Find 
the measured voltages of the output for the maximum 
and minimum values using the DAC Single Shot to set 
the DAC output to the ideal voltages. Enter the measured 
voltages in the Measured (V) numeric boxes and click 
Calculate to find the new offset and gain. Check the 
Enable Calibration to use these values to calculate the 
voltage outputs.

Figure 2. MAX1127X EV Kit Software (DAC Config Tab)
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Function Generator
When using the FPGA mode, the Function Generator 
tab allows the user to generate a signal with the DAC. 
Select the Number of Samples, DAC Update Rate, and 
Signal Frequency. Click Calculate to get the Adjust 
Frequency for the DAC signal needed for coherent sam-
pling. Then select the Signal Type, Amplitude, Phase, and 
Offset to set up the waveform desired for the DAC. Click 

Generate to find the DAC codes for the waveform and 
generate the waveform on the DAC. The waveform codes 
sent to the DAC is displayed on the graph. The Average, 
RMS, Maximum, Minimum, and Peak to Peak are also 
calculated and displayed on the right. To save the DAC 
code waveform, go to Options > Save Graph > Function 
Generator. This saves the settings on the left and the 
data in the graph to a csv file.

Figure 3. MAX1127X EV Kit Software (Function Generator Tab)
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Scope Tab
The Scope tab sheet is used to capture data and dis-
play it in the time domain. Sample Rate and Number 
of Samples can also be set in this tab if they were not 
appropriately adjusted in other tabs. The Display Unit 
drop-down list allows counts and voltages. Once the 
desired configuration is set, click on the Capture button. 
The right side of the tab sheet displays details of the wave-

form, such as Average, Standard Deviation, Maximum, 
Minimum, and Fundamental Frequency. Figure 4 displays 
the ADC data when a sinusoidal signal is applied at the 
inputs on the EV kit.
To save the captured data to a file, go to Options > Save 
Graph > Scope. This saves the setting on the left and the 
data captured to a csv file.

Figure 4. MAX1127X EV Kit Software (Scope Tab)
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DMM Tab
The DMM tab sheet provides captured data as a digital 
multimeter. Once the desired configuration is set, click on 
the Capture button. Figure 5 displays the results shown 

by the DMM tab when ADC_INP and ADC_INN (J26 and 
J27 set as 7-8) are set to REF, see Table 2 for jumper 
positions.

Figure 5. MAX1127X EV Kit Software (DMM Tab)
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Histogram Tab
The Histogram tab sheet is used to display a histogram of 
the captured data. Sampling rate and number of samples 
can also be set in this tab if they were not appropriately 
adjusted in other tabs. Once the desired configuration is 
set, click on the Capture button. The right side of the tab 
sheet displays details of the histogram such as Average, 
Standard Deviation, Maximum, Minimum, Peak-to-Peak 

Noise, Effective Resolution, and Noise-Free Resolution. 
To use this histogram feature, apply a DC voltage at the 
input. Figure 5 displays the results shown by the DMM tab 
when ADC_INP and ADC_INN are set to REF, see Table 
2 for jumper positions.
To save the histogram data to a file, go to Options > Save 
Graph > Histogram. This saves the setting on the left 
and the histogram data captured to a csv file.

Figure 6. MAX1127X EV Kit Software (Histogram Tab)
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FFT Tab
The FFT tab sheet is used to display the frequency domain  
FFT of the captured data. Sample Rate and Number of 
Samples can also be set in this tab if they were not appro-
priately adjusted in other tabs. Once the desired configura-
tion is set, click on the Capture button. The right side of 

the tab displays the performance based on the FFT, such 
as Fundamental Frequency, THD, SNR, SINAD, SFDR, 
ENOB, and Noise Floor.
To save the FFT data to a file, go to Options > Save 
Graph > FFT. This saves the setting on the left and the 
FFT data captured to a csv file. 

Figure 7. MAX1127X EV Kit Software (FFT Tab)
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ADC Registers Tab
The ADC Registers tab sheet shows the ADC registers 
on the left. The middle section shows the bits and bit 
descriptions of the selected register. Click Read All to 
read all registers and refresh the window with the register 
settings. To write a register first, select the hex value in 
the Value (Hex) column, type the desired hex value and 
press Enter. 

The Command Byte is on the right side of the tab sheet. 
This byte precedes all SPI transactions and is described 
in the ADC data sheet. To send a command byte, enter a 
hex value in the Numeric box and click the Send button. 
The command byte has two different formats including 
Conversion Mode and Register Access Mode. Select the 
radio button for the desired mode to see the bit descrip-
tion in the table.

Figure 8. MAX1127X EV Kit Software (ADC Registers Tab)
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Detailed Description of Hardware
This EV kit provides a proven layout to demonstrate the 
performance of the MAX1127X 24-bit delta-sigma ADC. 
Included in the EV kit are digital isolators (MAX14934), 
ultra-low-noise LDOs (MAX8842) to all supply pins of 
the IC, an on-board reference (MAX6126), a precision 
amplifier (MAX44241) for the analog inputs, 16-bit DAC 
(MAX542) with precision amplifiers (MAX9632), and sync-
in and sync-out signals for coherent sampling. 
An on-board controller is provided to allow for evaluation 
in standalone mode, which has limitations on maximum 
sample size and it cannot perform coherent sampling. 
The EV kit can be used with FPGA mode to achieve larger 
sample depth and coherent sampling.
The ADC has several input options which are selected by 
J26 and J27. The external option allows for wires attached 
to the screw terminals at J10. The amplifier option allows 
for signals at testpoints CH_A to CH_D. The DAC option 
allows for inputs to be driven from an on-board DAC. The 
REF options connect the inputs to the voltage reference 
of the ADC.

User-Supplied SPI
To evaluate the ADC on this EV kit with a user-supplied 
SPI bus, disconnect from the FMC bus and remove 
jumper J20. Apply the user-supplied SPI signals to SCLK, 
CSB, DIN, and DOUT at the PMOD_A header (J32). 
Make sure the return ground is connected to PMOD 
ground. To communicate to the on-board DAC connect 
the user-supplied SPI signals to CSB, SCLK, DIN, and 
LDAC at the PMOD_B header (J33). Make sure the return 
ground is connected to PMOD ground.
The on-board FTDI chip used for standalone mode does 
not conflict with the user-supplied SPI if it is powered off 
by removing jumper J20.
Caution: Do not plug this header into a standard PMOD 
interface found on other FPGA or microcontroller prod-
ucts. The signal definition is unique to this EV kit.

User-Supplied Reference
For user-supplied reference voltage, set jumpers at J21 
and J23 to positions 2-3 and apply external reference to 
either J9 or to the EXT_REFN and EXT_REFP testpoints.

User-Supplied AVSS 
The AVSS supply is set to GND or -1.8V by Jumper J5. 
For user-supplied AVSS, remove the jumper from J5 and 
apply AVSS to the screw-terminals/testpoint at J13. Make 
sure that this external supply has the correct relation to 
system ground.

User-Supplied AVDD 
The AVDD supply is set to 3.6V or 1.8V by jumper J8. 
For user-supplied AVDD, remove the jumper from J8 and 
apply AVDD to the screw-terminals/testpoint at J13. Make 
sure that this external supply has the correct relation to 
system ground.

Bipolar Powered vs. Unipolar Powered
The ADC supports both unipolar and bipolar ranges. For 
unipolar mode, jumper J8 pins 2-3 to power AVDD with 
3.6V and jumper J5 pins 1-2 to set AVSS to GND. For 
bipolar mode, jumper J8 pins 1-2 to power AVDD with 
1.8V and jumper J5 pins 2-3 to set AVSS to -1.8V.

External Clock 
When the ADC is configured to use an external clock, 
Jumper J36 pins 2-3 to select the on-board oscillator as 
the clock source. Jumper J36 pins 1-2 to select the SMA 
connector (and user-provided clock) as the clock source.

GPIO 
Testpoints are provided for the three GPIO signals from 
the ADC, GPIO1, GPIO2, and GPIO3. The ADC Config 
tab can configure these as input/output and read/drive the 
GPIO pins. GPIO1 connects to a FET which allows J14.1 
and TP2 to be connected to ground by driving GPIO1 high 
(note that DVDD should be to 3.3V to drive the FET).

ADC Input Amplifiers
The input amplifiers allow for significant flexibility. The 
amplifier input stage begins with testpoints labeled CH_A 
to CH_D. Each set of testpoints has options to ground 
either the inverting or noninverting inputs. The jumper 
block J29 and J25 allow for bypassing the first stage of 
amplifiers, or connecting the first stage to the second 
stage. Jumper J7 can provide an offset of 2.5V to the 
CH_A/CH_B signals – leave unpopulated to have an 
offset of 0V. Similarly, jumper J6 can provide an offset of 
2.5V to the CH_C/CH_D signals – leave unpopulated to 
have an offset of 0V. 

DAC and DAC Amplifiers
In Figure 2, the GUI shows a functional diagram of the 
DAC and DAC amplifiers. Here jumper J45 can be con-
nected to 2.5V to add a 2.5V offset to the DAC_OUT+ 
signal, and J44 can be connected to 2.5V to add 2.5V to 
the DAC_OUT- signal.
The value at DAC_OUT+ and DAC_OUT- are available to 
drive to the ADC by use of jumpers J26 and J27.
Also, please note that the DAC_OUT+ and DAC_OUT- 
values shown by the GUI are only valid if the settings at 
J44 and J45 are the same on both the PCB and the GUI.
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Figure 9. Analog Front-End
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Table 4. Analog Input Configurations (Ch A - D)
CONFIGURATION SIGNAL-PATH INPUT 

CONFIGURATION INPUT CONNECTORS JUMPER POSITIONS
No. DESCRIPTION

1 Channel A and C
Noninverting, differential, 

second-order LPF 
(default)

CH_A- and CH_C-

J28: 3-4
J30: 3-4
J24: 3-4
J22: 3-4

J29: 1-2 and 7-8
J25: 1-2 and 7-8

J26: 3-4
J27: 3-4

J7: 1-2 (for bipolar signal) or 
Open for unipolar signal 

J8: 1-2 (for bipolar signal) or 
Open for unipolar signal

2 Channel A and C Inverting, differential, 
second-order LPF CH_A+ and CH_C+

J28: 1-2
J30: 3-4
J24: 1-2
J22: 3-4

J29: 1-2 and 7-8
J25: 1-2 and 7-8

J26: 3-4
J27: 3-4

J7: 1-2 (for bipolar signal) or 
Open for unipolar signal

J8: 1-2 (for bipolar signal) or 
OPEN for unipolar signal

3 Channel B and D Noninverting, differential, 
first-order LPF CH_B+ and CH_D+

J28: 1-2 and 3-4
J30: 1-2

J24: 1-2 and 3-4
J22: 1-2

J29: 3-4 and 7-8
J25: 3-4 and 7-8

J26: 3-4
J27: 3-4

J7: 1-2 (for bipolar signal) or 
Open for unipolar signal

J8: 1-2 (for bipolar signal) or 
Open for unipolar signal

4 Channel B and D Inverting, differential, first-
order LPF CH_B- and CH_D-

J28: 1-2 and 3-4
J30: 3-4

J24: 1-2 and 3-4
J22: 3-4

J29: 3-4 and 7-8
J25: 3-4 and 7-8

J26: 3-4
J27: 3-4

J7: 1-2 (for bipolar signal) or 
Open for unipolar signal

J8: 1-2 (for bipolar signal) or 
Open for unipolar signal
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Table 4. Analog Input Configurations (Ch A - D) (continued)
CONFIGURATION SIGNAL-PATH INPUT 

CONFIGURATION INPUT CONNECTORS JUMPER POSITIONS
No. DESCRIPTION

5 External Inputs User-supplied signals IN+ and IN-

J28: 1-2 and 3-4
J30: 1-2 and 3-4
J24: 1-2 and 3-4
J22: 1-2 and 3-4
J29: 3-4 and 7-8
J25: 3-4 and 7-8

J26: 1-2
J27: 1-2
J7: Open
J8: Open

6 DAC Output DAC output buffered with 
MAX9632 

DAC_OUT+ and DAC_
OUT-

J28: 1-2 and 3-4
J30: 1-2 and 3-4
J24: 1-2 and 3-4
J22: 1-2 and 3-4
J29: 3-4 and 7-8
J25: 3-4 and 7-8

J26: 5-6
J27: 5-6
J7: Open
J8: Open

7 ADC Voltage Reference

Voltage reference input 
to ADC from MAX6126 or 
external source (see J21 

and J23)

ADC_REFP and ADC_
REFN

J28: 1-2 and 3-4
J30: 1-2 and 3-4
J24: 1-2 and 3-4
J22: 1-2 and 3-4
J29: 3-4 and 7-8
J25: 3-4 and 7-8

J26: 7-8
J27: 7-8
J7: Open
J8: Open
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Figure 10a. MAX11270 EV Kit Schematic (Sheet 1 of 6)
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Figure 10b. MAX11270 EV Kit Schematic (Sheet 2 of 6)
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Figure 10c. MAX11270 EV Kit Schematic (Sheet 3 of 6)
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Figure 10d. MAX11270 EV Kit Schematic (Sheet 4 of 6)
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Figure 10e. MAX11270 EV Kit Schematic (Sheet 5 of 6)

TE
RM

IN
AL

BL
OC

KS

RE
VA

OF
M

AX
11

27
0E

VK
IT

DO
ES

NO
T

HA
VE

R8
6

AN
D

R8
7

AN
D

J2
7.

9
IS

AS
SI

GN
ED

TO
GN

D,
NO

T
AD

C_
RE

F/
2

AD
C_

IN
N

AD
C_

RE
FP

DA
C_

OU
T+

AD
C_

RE
F/

2

10

AD
C_

RE
FP

AD
C_

RE
F/

2

10
K

AD
C_

IN
P

AD
C_

RE
FN

10
00

PF

PB
C0

5D
AA

N

EX
T+

AM
P+

PB
C0

5D
AA

N

10

EX
T_

RE
FP

EX
T_

RE
FN

+10V

-1
0V

AG
ND

AD
C_

RE
FP

AM
P-

49
.9

+2
.5

V

MA
X4

42
41

AU
K+

0.1
UF

PB
C0

4D
AA

N

1U
F

TP

TP
EX

T_
RE

FN

2N
70

02

10
0

TP

AV
SS

AV
DD

PB
C0

4D
AA

N

+2
.5

V

-10V

MA
X4

42
41

AU
K+

-10V

MA
X4

42
41

AU
K+

10
00

PF

10
00

PF
MA

X4
42

41
AU

K+

-10V

TP TPTP

10
K

10
00

PF

10
K

10
00

PF

1U
F

+1
0V +1
0V

IN
-

AD
C_

RE
FP

OS
TT

A0
20

16
1

IN
-

IN
+

+10V

10
00

PF

10
K

0.1
UF

1U
F

-1
0V

TP

10
K

10
K

TP

10
K

10
K

TP TP
0

-1
0V

0.1
UF

10
K

10
K

10
00

PF

10
K

TPTP

IN
+

TP

TP

0

TP
0 0

0

1M 1M

4.
99

10
K

1U
F

4.
99

0.1
UF

10
K

10
K

1M 1M1M

TP

10
K

1M1M

TP TPTP

10
K

1U
F

10
K

10
00

PF

1M

10
00

PF

+10V

-1
0V

10
0K

10
0K

10
0

GP
IO

2
GP

IO
3

1U
F

10
0

GP
IO

1

AV
DD

AV
SS

+1
0V

-1
0V

DA
C_

OU
T+

0.1
UF

1U
F

0.1
UF

1U
F+1

0V

DA
C_

OU
T-

TPTP

OS
TT

A0
20

16
1

OS
TT

A0
20

16
1

TP
EX

T_
RE

FP

0.1
UF

10
K

+10V

0.1
UF

10
K

-10V

49
.9

OS
TT

A0
20

16
1

10
0K

PB
C0

3S
AB

N

+1
0V

PB
C0

3S
AB

N

DA
C_

OU
T-

10
K

EX
T-

AD
C_

RE
FN

C1
02

C1
18

A_
IN

P1

C1
24

C9
9

C1
07

J2
8

J3
0

J2
4

J2
2

G3

J2
6

J2
7

J1
4

J1
3

J9J1
0

8
7

6
51 3

42 8
7

6
51 3

42

4
3

2
1

4
3

2
1

4
3

2
1

4
3

2
1

RB
47

RB
43

R8
2

R7
6

RB
62

R6
7

RB
59

R7
9

RB
55

RB
57

R7
3

R7
4

R7
7

R6
6

RB
44

RB
40

RB
42

R6
9

R6
4

R6
8

RB
54

RB
53

RB
52 RB

56

RB
65

RB
63

RB
38

RB
39

RB
37

RB
41

RB
34

RB
36

RB
60

RB
30

RB
27

RB
28

C8
8

C1
00

C1
03

C9
0

C1
12

C1
21

C1
19

C1
10

C1
17

C1
20

C1
23

C1
13

C1
01

C1
04

C9
4

C8
9

RB
61

RB
64

R8
1

RB
66

RB
58

RB
46

RB
45

VS
S

VD
D

IN
A-

IN
A+

OU
TA

VS
S

VD
D

IN
A-

IN
A+

OU
TA

VS
S

VD
D

IN
A-

IN
A+

OU
TA

VS
S

VD
D

IN
A-

IN
A+

OU
TA

G
SD

ININ ININOU
T

OU
T

OU
T

OU
T

IN

IN

ININ

IN

IN IN

OU
T

OU
T

C1
22

U2
7

A_
IN

P2

C1
25

J2
9

U2
6

U2
4

C_
IN

P2

J2
5

U2
3

C_
IN

P1

C1
05

QB
1

C1
33

AV
DD

EX
T_

RE
FN

EX
T_

RE
FP

IN
+

GP
IO

3

GP
IO

2

IN
-

CH
_D

+

CH
_D

-

CH
_C

+

CH
_C

-

CH
_B

+

CH
_B

-

CH
_A

+

CH
_A

-

AV
SS

TP
2

10

10
9

8
7

6
5

4
3

2
1

9
8

7
6

5
4

3
2

1

2121

2121

2 2

1
4 3

8
7

6
5

4
3

2
1

1
4 3

1
4 3

8
7

6
5

4
3

2
1

1
4 3

4
3

2
1

4
3

2
1

4
3

2
1

4
3

2
1

1

R8
7

R8
6

J7

J6

31 31

25

25

25

25

23



Maxim Integrated  │ 24www.maximintegrated.com

Evaluates: MAX11270MAX1127X Family Evaluation Kit

Figure 10f. MAX11270 EV Kit Schematic (Sheet 6 of 6)
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Figure 11. MAX11270 EV Kit Component Placement Guide—Top Side
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Figure 12. MAX11270 EV Kit PCB Layout—Layer 1
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Figure 13. MAX11270 EV Kit PCB Layout—Layer 2
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Figure 14. MAX11270 EV Kit PCB Layout—Layer 3
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Figure 15. MAX11270 EV Kit PCB Layout—Layer 4
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Figure 16. MAX11270 EV Kit PCB Layout—Layer 5

1”



Maxim Integrated  │ 31www.maximintegrated.com

Evaluates: MAX11270MAX1127X Family Evaluation Kit

Figure 17. MAX11270 EV Kit PCB Layout—Layer 6
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Figure 18. MAX11270 EV Kit Component Placement Guide—Bottom Side
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#Denotes RoHS compliant.

Refer to file “evkit_bom_max11270_evkit_b.csv” 
attached to this data sheet for component information.
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		TITLE: Bill of Materials																						

		DATE: 09/24/2014																						

		DESIGN: max11270_revA																						

		ITEM		QTY		REF DES		Var Status		MAXINV		MFG PART #		MANUFACTURER		VALUE		DESCRIPTION		STATUS		COMMENTS		

		1		14		 +5V,+10V,+1.8V,+2.0V,+2.5V,+3.3V,-1.8V,A3.6V,D3.6V,+10VEXT,+15VEXT,-15VEXT,-10V,AVDD		Pref		02-TPMINI5005-00		5005		?		N/A		TESTPOINT WITH 1.80MM HOLE DIA, RED, COMPACT; NOT FOR COLD TEST		ACTIVE				

		2		5		G1,G3,G4,G2,G5		Pref		02-TPCOMP5007-00		5006		?		N/A		TEST POINT; PIN DIA=0.125IN; TOTAL LENGTH=0.35IN; BOARD HOLE=0.063IN; BLACK; PHOSPHOR BRONZE WIRE SILVER PLATE FINISH; RECOMMENDED FOR BOARD THICKNESS=0.062IN; NOT FOR COLD TEST		ACTIVE				

		3		30		DAC+,DAC-,BUFF_OUT,BUFF_OUT1,BUFF_OUT2,IN+,IN-,TP2,AVSS,CH_A+,CH_A-,CH_B+,CH_B-,CH_C+,CH_C-,CH_D+,CH_D-,GPIO1-GPIO3,A_INP1,A_INP2,C_INP1,C_INP2,-10VEXT,ADC_INN,ADC_INP,ADC_CAPR,ADC_REFN,ADC_REFP,EXT_REFN,EXT_REFP		Pref		02-TPMINI5001-00		5007		?		N/A		TEST POINT; PIN DIA=0.125IN; TOTAL LENGTH=0.35IN; BOARD HOLE=0.063IN; White PHOSPHOR BRONZE WIRE SILVER PLATE FINISH; RECOMMENDED FOR BOARD THICKNESS=0.062IN; NOT FOR COLD TEST		ACTIVE				

		4		15		C1,C2,C8,C10,C25-C27,C34-C37,C43,C53,C60,C70		Pref		20-0001U-89		N/A		?		1UF		CAPACITOR; SMT (0805); CERAMIC CHIP; 1UF; 25V; TOL=10%; MODEL=; TG=-55 DEGC TO +125 DEGC; TC=X7R-NOT RECOMMENDED FOR NEW DESIGN-USE 20-0001u-04		NOT RECOMMENDED				

		5		53		C3,C5,C9,C11,C14-C18,C21,C22,C29,C30,C32,C33,C39,C41,C42,C45,C47,C49,C52,C56,C58,C61,C63,C65,C67,C69,C73,C74,C77-C81,C86,C90,C94,C97,C98,CB4,CB5,C101,C103,C110,C111,C113,C119,C123,C128-C130		Pref		20-000U1-03		N/A		?		0.1UF		CAPACITOR; SMT; 0603; CERAMIC; 0.1uF; 25V; 10%; X7R; -55degC to + 125degC;  +/-15% from -55degC to +125degC; NOT RECOMMENDED FOR NEW DESIGN USE - 20-000u1-01		NOT RECOMMENDED				

		6		2		C4,C12		Pref		20-0180P-83		N/A		?		180PF		CAPACITOR; SMT (0603); CERAMIC CHIP; 180PF; 50V; TOL=10%; MODEL=C0G; TG=-55 DEGC TO +125 DEGC; TC=+/		ACTIVE				

		7		1		C6		Pref		20-00U47-P6		N/A		?		0.47UF		CAPACITOR; SMT (0603); CERAMIC CHIP; 0.47UF; 25V; TOL=10%; MODEL=GRM SERIES; TG=-55 DEGC TO +125 DEGC; TC=X7R		EVKIT-NOT FOR TEST				

		8		7		C7,C13,C23,C28,C40,C57,CB1		Pref		20-0010U-E6A		N/A		?		10UF		CAPACITOR; SMT (0805); CERAMIC CHIP; 10UF; 25V; TOL=10%; MODEL=; TG=-55 DEGC TO +85 DEGC; TC=X5R		ACTIVE				

		9		3		C19,C20,C24		Pref		20-004U7-E6		N/A		?		4.7UF		CAPACITOR; SMT (0805); CERAMIC CHIP; 4.7UF; 25V; TOL=10%; MODEL=X5R; TG=-55 DEGC TO +125 DEGC; TC=+/		ACTIVE				

		10		3		C31,C54,C82		Pref		20-004U7-63		N/A		?		4.7UF		CAPACITOR; SMT (0805); CERAMIC CHIP; 4.7UF; 25V; TOL=10%; MODEL=; TG=-55 DEGC TO +125 DEGC; TC=X7R		EVKIT-NOT FOR TEST				

		11		24		C38,C44,C46,C48,C50,C55,C62,C64,C68,C75,C76,C88,C89,C91,C92,C96,C100,C104,C112,C117,C120,C121,C126,C127		Pref		20-0001U-63		N/A		?		1UF		CAPACITOR; SMT (0603); CERAMIC CHIP; 1UF; 16V; TOL=10%; MODEL=; TG=-55 DEGC TO +125 DEGC; TC=X7R		TEMPLATE				

		12		3		C51,C59,C66		Pref		20-0U047-12		N/A		?		0.047UF		CAPACITOR; SMT; 0603; CERAMIC;  0.047uF; 25V; 10%; X7R; -55degC to + 125degC;  0 +/-15% degC MAX., USE 20-0u047-91 FOR NEW DESIGN		NOT RECOMMENDED				

		13		1		C71		Pref		20-0U001-N4A		N/A		?		0.001UF		CAPACITOR; SMT (0603); CERAMIC CHIP; 0.001UF; 25V; TOL=20%; MODEL=C SERIES; TG=-55 DEGC TO +125 DEGC; TC=C0G		EVKIT-NOT FOR TEST				

		14		1		C72		Pref		20-0010P-25		N/A		?		10PF		CAPACITOR; SMT; 0603; CERAMIC; 10pF; 50V; 5%; C0G; -55degC to + 125degC, USE 20-0010p-E4 FOR NEW DESIGN		NOT RECOMMENDED				

		15		3		C83,C87,C108		Pref		N/A		N/A		N/A		?		CAPACITOR; 0603 PACKAGE; GENERIC		EVKIT-CUSTOM				

		16		10		C84,C85,C99,C102,C105,C107,C118,C122,C124,C125		Pref		20-1000P-80		N/A		?		1000PF		CAPACITOR; SMT; 0603; CERAMIC; 1000pF; 50V; 5%; C0G; -55degC to +125degC, USE 20-1000p-E4 FOR NEW DESIGN		NOT RECOMMENDED				

		17		2		C93,C109		Pref		20-00U01-R0		N/A		?		0.01UF		CAPACITOR; SMT (0603); CERAMIC CHIP; 0.01UF; 25V; TOL=5%; MODEL=; TG=-55 DEGC TO +125 DEGC; TC=C0G		ACTIVE				

		18		3		C95,CB6,C115		Pref		20-00U01-11		N/A		?		0.01UF		CAPACITOR; SMT (0603); CERAMIC; 0.01UF; 16V; TOL=10%; MODEL=GRM SERIES; TG=-55 DEGC TO +125 DEGC; TC=X7R		EVKIT-NOT FOR TEST				

		19		2		C106,C114		Pref		20-1000P-F5		N/A		?		1000PF		CAPACITOR; SMT (0603); CERAMIC CHIP; 1000PF; 50V; TOL=1%; MODEL=GRM SERIES; TG=-55 DEGC TO +125 DEGC; TC=C0G		EVKIT-NOT FOR TEST				

		20		2		C116,C131		Pref		20-1000P-04		N/A		?		1000PF		CAPACITOR; SMT; 0603; CERAMIC; 1000pF; 50V; 10%; X7R; -55degC to + 125degC;  +/-15% from -55degC to +125degC, USE 20-1000p-E4 FOR NEW DESIGN		NOT RECOMMENDED				

		21		2		CB2,CB3		Pref		20-0018P-77		N/A		?		18PF		CAPACITOR; SMT (0603); CERAMIC CHIP; 18PF; 50V; TOL=5%; MODEL=; TG=-55 DEGC TO +125 DEGC; TC=C0G		EVKIT-NOT FOR TEST				

		22		3		D1,D2,DB1		Pref		30-MBR0520L-00		MBR0520L		FAIRCHILD SEMICONDUCTOR		MBR0520L		DIODE, SCHOTTKY, SOD-123, PIV=20V, Vf=0.385V@If=0.5A, If(ave)=0.5A		ACTIVE				

		23		1		DS1		Pref		30-LSL29KG1J21Z-00		LS L29K-G1J2-1-Z		OSRAM		LS L29K-G1J2-1-Z		DIODE; LED; SMART; RED; SMT (0603); PIV=1.8V; IF=0.02A; -40 DEGC TO +100 DEGC		EVKIT-NOT FOR TEST				

		24		2		DS2,DSB1		Pref		30-LGL29KG2J124-00		LG L29K-G2J1-24		OSRAM		LG L29K-G2J1-24		DIODE; LED; SMT (0603); Vf=1.7V; If(test)=0.002A; -40 DEGC TO +100 DEGC		ACTIVE				

		25		1		J1		Pref		01-101181920001LF5P-26		10118192-0001LF		FCI CONNECT		10118192-0001LF		CONNECTOR; FEMALE; SMT; MICRO USB B TYPE RECEPTACLE; RIGHT ANGLE; 5PINS		EVKIT-NOT FOR TEST				

		26		4		J2,J3,J6,J7		Pref		01-PBC03SABN3P-21		PBC03SABN		SULLINS		PBC03SABN		CONNECTOR; MALE; THROUGH HOLE; BREAKAWAY; STRAIGHT; 3PINS		ACTIVE				

		27		9		J4,J5,J8,J21,J23,J36,J40,J44,J45		Pref		01-PBC03SAAN3P-21		PBC03SAAN		SULLINS		PBC03SAAN		CONNECTOR; MALE; THROUGH HOLE; BREAKAWAY; STRAIGHT; 3PINS; -65 DEGC TO +125 DEGC		EVKIT-NOT FOR TEST				

		28		5		J9,J10,J11-J14		Pref		01-OSTTA0201612P-25		OSTTA020161		ON-SHORE TECHNOLOGY INC.		OSTTA020161		CONNECTOR; FEMALE; THROUGH HOLE; 5MM TERMINAL BLOCK CONNECTOR; STRAIGHT; 2PINS		EVKIT-NOT FOR TEST				

		29		4		J15,J20,J37,J46		Pref		01-PCC02SAAN2P-21		PCC02SAAN		SULLINS		PCC02SAAN		CONNECTOR; MALE; THROUGH HOLE; BREAKAWAY; STRAIGHT THROUGH; 2PINS; -65 DEGC TO +125 DEGC		ACTIVE				

		30		1		J16		Pref		01-KLDX0202B3P-27		KLDX-0202-B		KYCON		KLDX-0202-B		CONNECTOR; FEMALE; THROUGH HOLE; DC POWER JACK; RIGHT ANGLE; 3PINS		EVKIT-NOT FOR TEST				

		31		2		J17,J18		Pref		01-PBC03DAAN6P-21		PBC03DAAN		SULLINS ELECTRONICS CORP.		PBC03DAAN		CONNECTOR; MALE; THROUGH HOLE; BREAKAWAY; STRAIGHT; 6PINS; -65 DEGC TO +125 DEGC		EVKIT-NOT FOR TEST				

		32		1		J19		Pref		01-PBC06SAAN6P-21		PBC06SAAN		SULLINS ELECTRONICS CORP.		PBC06SAAN		CONNECTOR; MALE; THROUGH HOLE; BREAKAWAY; STRAIGHT; 6PINS; -65 DEGC TO +125 DEGC		EVKIT-NOT FOR TEST				

		33		4		J22,J24,J28,J30		Pref		01-PBC02DAAN4P-21		PBC02DAAN		SULLINS ELECTRONIC CORP.		PBC02DAAN		CONNECTOR; MALE; THROUGH HOLE; BREAKAWAY; STRAIGHT; 4PINS		EVKIT-NOT FOR TEST				

		34		2		J25,J29		Pref		01-PBC04DAAN8P-21		PBC04DAAN		SULLINS ELECTRONICS CORP.		PBC04DAAN		CONNECTOR; MALE; THROUGH HOLE; BREAKAWAY; STRAIGHT; 8PINS; -65 DEGC TO +125 DEGC		EVKIT-NOT FOR TEST				

		35		5		J31,J34,J38,J41,J42		Pref		01-7339100605P-10		73391-0060		MOLEX		73391-0060		CONNECTOR; FEMALE; THROUGH HOLE; SMA JACK CONNECTOR; STRAIGHT; 5PINS		EVKIT-NOT FOR TEST				

		36		2		J32,J33		Pref		01-TSW10608SDRA12P-17		TSW-106-08-S-D-RA		SAMTEC		TSW-106-08-S-D-RA		CONNECTOR; THROUGH HOLE; DOUBLE ROW; RIGHT ANGLE; 12PINS; THIS PART IS DEDICATED FOR PMOD PERIPHERAL BOARD		EVKIT-NOT FOR TEST				

		37		2		J35,J39		Pref		01-PBC10SAAN10P-21		PBC10SAAN		SULLINS ELECTRONICS CORP.		PBC10SAAN		CONNECTOR; MALE; THROUGH HOLE; BREAKAWAY; STRAIGHT; 10PINS; -65 DEGC TO +125 DEGC		ACTIVE				

		38		1		J43		Pref		01-ASP13460401160P-17		ASP-134604-01		SAMTEC		ASP-134604-01		CONNECTOR; MALE; SMT; HIGH SPEED/HIGH DENSITY OPEN PIN FIELD TERMINAL ARRAY; STRAIGHT; 160PINS		NOT RECOMMENDED				

		39		5		L1-L5		Pref		50-00600-S8A		MPZ1608S601A		TDK		600		INDUCTOR; SMT (0603); FERRITE-BEAD; 600; TOL=+/-25%; 1A; -55 DEGC TO +125 DEGC		EVKIT-NOT FOR TEST				

		40		1		QB1		Pref		90-2N7002-06		2N7002		N/A		2N7002		TRAN; ; NCH; SOT-23; PD-(0.33W); IC-(0.5A); VCEO-(60V); EVKIT PART FOR FORM FACTOR PROJECT		EVKIT-CUSTOM				

		41		43		R1,R2,R19,R21-R25,R27,R31,R35,R37,R46-R48,R50-R52,R54,R57-R59,R62,R63,R65,RB7,RB9,RB12,RB14,RB16,RB18,RB19,RB23,RB25,RB26,RB31-RB33,RB35,RB48-RB51		Pref		80-0028R-24		N/A		?		28		RESISTOR; 0603; 28 OHM; 1%; 100PPM; 0.10W; THICK FILM		EVKIT-NOT FOR TEST				

		42		7		R3,R5,R18,R38,RB60,RB61,RB64		Pref		80-0100K-24		N/A		?		100K		RESISTOR; 0603; 100K; 1%; 100PPM; 0.10W; THICK FILM		TEMPLATE				

		43		2		R4,R8		Pref		80-0715K-24		N/A		?		715K		RESISTOR; 0603; 715K OHM; 1%; 100PPM; 0.10W; METAL FILM		EVKIT-NOT FOR TEST				

		44		4		R6,R7,RB1,RB2		Pref		80-0001K-24		N/A		?		1K		RESISTOR; 0603; 1K; 1%; 100PPM; 0.10W; THICK FILM		TEMPLATE				

		45		8		R9,R32,R64,R73,RB27-RB30		Pref		80-0000R-27		N/A		?		0		RESISTOR; 0603; 0 OHM; 0%; JUMPER; 0.10W; THICK FILM		TEMPLATE				

		46		2		R10,R11		Pref		80-06K04-24		N/A		?		6.04K		RESISTOR; 0603; 6.04K; 1%; 100PPM; 0.10W; THICK FILM		ACTIVE				

		47		1		R12		Pref		80-0150K-24		N/A		?		150K		RESISTOR, 0603, 150K OHM,1%, 100PPM, 0.10W, THICK FILM		ACTIVE				

		48		2		R13,R14		Pref		80-0453K-24		N/A		?		453K		RESISTOR; 0603; 453K OHM; 1%; 100PPM; 0.10W; THICK FILM		EVKIT-NOT FOR TEST				

		49		4		R15-R17,R26		Pref		80-0237K-24		N/A		?		237K		RESISTOR; 0603; 237K OHM; 1%; 100PPM; 0.10W; THICK FILM		ACTIVE				

		50		1		R20		Pref		80-0169K-24		N/A		?		169K		RESISTOR; 0603; 169K OHM; 1%; 100PPM; 0.10W; THICK FILM		ACTIVE				

		51		1		R28		Pref		80-0105K-24		N/A		?		105K		RESISTOR; 0603; 105K OHM; 1%; 100PPM; 0.10W; THICK FILM		ACTIVE				

		52		38		R29,R30,R33,R36,R40-R43,R56,R60,R66-R69,R74,R76,R77,R79,RB5,RB6,RB8,RB11,RB13,RB15,RB20-RB22,RB24,RB38-RB40,RB42,RB44,RB53-RB55,RB57,RB59		Pref		80-0010K-24		N/A		?		10K		RESISTOR; 0603; 10K; 1%; 100PPM; 0.10W; THICK FILM		TEMPLATE				

		53		1		R34		Pref		80-0010R-53		N/A		?		10		RESISTOR; 0603; 10 OHM; 5%; 200PPM; 0.10W; THICK FILM		EVKIT-NOT FOR TEST				

		54		1		R39		Pref		80-0100R-53		N/A		?		100		RESISTOR; 0603; 100 OHM; 5%; 200PPM; 0.10W; THICK FILM		EVKIT-NOT FOR TEST				

		55		3		R44,RB43,RB47		Pref		80-0010R-24		N/A		?		10		RESISTOR; 0603; 10 OHM; 1%; 100PPM; 0.10W; THICK FILM		ACTIVE				

		56		1		R45		Pref		80-0039K-24		N/A		?		39K		RESISTOR, 0603, 39K OHM, 1%, 100PPM, 0.10W, THICK FILM		ACTIVE				

		57		11		R49,R55,R72,R75,R78,R80,R83-R85,RB45,RB46		Pref		80-049R9-24		N/A		?		49.9		RESISTOR; 0603; 49.9 OHM; 1%; 100PPM; 0.10W; THICK FILM		ACTIVE				

		58		4		R53,R61,R70,R71		Pref		80-0000R-U23		N/A		?		0		RESISTOR; 0603; 0 OHM; 5%; JUMPER; 0.063W; THICK FILM		EVKIT-NOT FOR TEST				

		59		2		R81,R82		Pref		80-04R99-24		N/A		?		4.99		RESISTOR; 0603; 4.99 OHM; 1%; 100PPM; 0.1W; THICK FILM		ACTIVE				

		60		1		RB3		Pref		80-0012K-24		N/A		?		12K		RESISTOR, 0603, 12K OHM, 1%, 100PPM, 0.10W, THICK FILM		ACTIVE				

		61		1		RB4		Pref		80-0015K-24		N/A		?		15K		RESISTOR, 0603, 15K OHM,1%, 100PPM, 0.10W, THICK FILM		ACTIVE				

		62		1		RB10		Pref		80-002K2-24		N/A		?		2.2K		RESISTOR, 0603, 2.2K OHM, 1%, 100PPM, 0.10W, THICK FILM		ACTIVE				

		63		1		RB17		Pref		80-004K7-19		N/A		?		4.7K		RESISTOR; 0603; 4.7K; 1%; 100PPM; 0.10W; THICK FILM		TEMPLATE				

		64		8		RB34,RB36,RB37,RB41,RB52,RB56,RB63,RB65		Pref		80-0001M-19		N/A		?		1M		RESISTOR; 0603; 1M; 1%; 100PPM; 0.10W; THICK FILM		TEMPLATE				

		65		3		RB58,RB62,RB66		Pref		80-0100R-24		N/A		?		100		RESISTOR; 0603; 100 OHM; 1%; 100PPM; 0.10W; THICK FILM		TEMPLATE				

		66		2		SYNC_CLK_IN,SYNC_CLK_OUT		Pref		02-TPCOMP5123-00		5123		?		N/A		TEST POINT; PIN DIA=0.125IN; TOTAL LENGTH=0.35IN; BOARD HOLE=0.063IN; GRAY; PHOSPHOR BRONZE WIRE SILVER PLATE FINISH; RECOMMENDED FOR BOARD THICKNESS=0.062IN; NOT FOR COLD TEST		EVKIT-NOT FOR TEST				

		67		1		T1		Pref		12-TGMH240V8LF-09		TGM-H240V8LF		HALO ELECTRONICS, INC		TGM-H240V8LF		TRANSFORMER; SMT; 1:1:1.3:1.3; DC/DC CONVERTER		EVKIT-NOT FOR TEST				

		68		2		U1,U4		Pref		30-BAS4002ARPP-00		BAS4002A-RPP		INFINEON		BAS4002A-RPP		DIODE; SCH; LOW VF SCHOTTKY DIODE ARRAY; SMT (SOT-143); PIV=40V; IF=0.2A		EVKIT-NOT FOR TEST				

		69		3		U2,U5,U11		Pref		MAX15006CATT+		MAX15006CATT+		MAXIM		MAX15006CATT+		IC; VREG; ULTRA-LOW QUIESCENT-CURRENT LINEAR REGULATOR; TDFN6-EP 3X3		EVKIT-NOT FOR TEST		 MAX15006CATT+		

		70		1		U3		Pref		MAX13256ATB+		MAX13256ATB+		MAXIM		MAX13256ATB+		IC; DRV; 36V H-BRIDGE TRANSFORMER DRIVER FOR ISOLATED SUPPLIES; TDFN10-EP 3X3		EVKIT-NOT FOR TEST		 MAX13256ATB+		

		71		1		U6		Pref		MAX15006BATT+		MAX15006BATT+		MAXIM		MAX15006BATT+		IC; VREG; ULTRA-LOW QUIESCENT-CURRENT LINEAR REGULATOR; TDFN6-EP 3X3		EVKIT-NOT FOR TEST		 MAX15006BATT+		

		72		4		U7-U9,U13		Pref		MAX8842ELT+		MAX8842ELT+		MAXIM INTEGRATED		MAX8842ELT+		IC; VREG; ULTRA-LOW-NOISE; HIGH PSRR; LOW-DROPOUT; LINEAR REGULATOR; UDFN6 1.5MM X 1.0MM		ACTIVE		 MAX8842ELT+		

		73		2		U10,U21		Pref		MAX6126AASA25+		MAX6126AASA25+		MAXIM		MAX6126AASA25		IC; SERIES VOLTAGE REFERENCE; ULTRA HIGH PRECISION; ULTRA LOW NOISE VOLTAGE REFERENCE; SOIC8 150MIL; Vout=2.5V, 3ppm/degC max TEMPCO		ACTIVE		 MAX6126AASA25+		

		74		2		U12,UB1		Pref		10-93LC66BTIOT-U		93LC66BT-I/OT		MICROCHIP		93LC66BT-I/OT		IC; EPROM; 4K MICROWIRE SERIAL EEPROM; SOT23-6		EVKIT-NOT FOR TEST				

		75		1		U14		Pref		MAX15006AATT+		MAX15006AATT+		MAXIM		MAX15006AATT+		IC; VREG; ULTRA-LOW QUIESCENT-CURRENT LINEAR REGULATOR; TDFN6-EP 3X3		EVKIT-NOT FOR TEST		 MAX15006AATT+		

		76		1		U15		Pref		MAX542AESD+		MAX542AESD+		MAXIM		MAX542AESD+		IC; DAC; SERIAL-INPUT, VOLTAGE-OUTPUT, 16-BIT DAC; NSOIC14 150MIL		ACTIVE		 MAX542AESD+		

		77		3		U16-U18		Pref		MAX9632AUA+		MAX9632AUA+		MAXIM		MAX9632AUA+		IC; OPAMP; PRECISION, LOW-NOISE, WIDE-BAND AMPLIFIER; UMAX8 ; -40 DEGC TO +125 DEGC		ACTIVE		 MAX9632AUA+		

		78		1		U19		Pref		MAX664ESA		MAX664ESA		MAXIM		MAX664ESA		IC, NEGATIVE VOLTAGE REGULATOR, DUAL MODE, 5V/PROGRAMMABLE, 2V TO 16.5V INPUT VOLTAGE RANGE,VS(MAX)=-18V, SOIC8-150MIL, -40degC TO +85degC		ACTIVE		 MAX664ESA		

		79		1		U20		Pref		60-8M192-17		FXO-HC730-8.192		FOX		FXO-HC730-8.192		OSCILLATOR; SMT 5X7; HCMOS; 8.192MHZ; NO DATA; +/-100PPM		EVKIT-NOT FOR TEST				

		80		3		U22,U29,U34		Pref		MAX14934FAWE		MAX14934FAWE		MAXIM		MAX14934FAWE		IC; DISO; LOW POWER QUAD CHANNELS DIGITAL ISOLATOR; WSOIC16 300MIL		ACTIVE				

		81		4		U23,U24,U26,U27		Pref		MAX44241AUK+		MAX44241AUK+		MAXIM 		MAX44241AUK+		IC; OPAMP; LOW NOISE; PRECISION; SINGLE OP AMPS; SOT23-5		ACTIVE		 MAX44241AUK+		

		82		1		U25		Pref		10-MAX11214EUG-U		MAX11214EUG+		N/A		MAX11214EUG+		EVKIT PART-IC; ADC; SINGLE CHANNEL MEDIUM SPEED DELTA-SIGMA ADC WITH SPI INTERFACE; TSSOP24		EVKIT-CUSTOM				

		83		2		U28,U30		Pref		10-74LVC2G125DP-U		74LVC2G125DP		?		74LVC2G125DP		IC; DRV; DUAL BUS BUFFER/LINE DRIVER; 3-STATE; TSSOP8		EVKIT-NOT FOR TEST				

		84		1		UB2		Pref		10-FT2232HL-C		FT2232HL		FUTURE TECHNOLOGY DEVICES INTL LTD.		FT2232HL		IC; MMRY; DUAL HIGH SPEED USB TO MULTIPURPOSE UART/FIFO; LQFP64		EVKIT-NOT FOR TEST				

		85		1		UB3		Pref		MAX3002EUP		MAX3002EUP		MAXIM		MAX3002EUP		IC, TRANS, 8-CHANNEL LEVEL TRANSLATOR, 20Mbps, ESD-PROTECTED		ACTIVE		 MAX3002EUP		

		86		1		YB1		Pref		60-0012M-19		ABM7-12.000MHZ-D2Y-T		ABRACON		12MHZ		CRYSTAL; SMT ; 18PF; 12MHZ; +/-20PPM; +/-30PPM		ACTIVE				

		87		2		J26,J27		Pref		01-PBC05DAAN10P-21		PBC05DAAN		SULLINS ELECTRONICS CORP.		PBC05DAAN		CONNECTOR; MALE; THROUGH HOLE; BREAKAWAY; STRAIGHT; 10PINS; -65 DEGC TO +125 DEGC		EVKIT-NOT FOR TEST				

		15		2		D3, D4		Pref		30-BAT54S-00		BAT54S		FAIRCHILD SEMICONDUCTOR		BAT54S		DIODE; SCH; SCHOTTKY DIODE; SMT (SOT-23); PIV=30V; IF=0.2A		EVKIT-NOT FOR TEST				

																								

		88		1		 		 Pref		123		123		MAXIM		 PCB		 PCB: 123						

		TOTAL		436																				

																								

		DO NOT PURCHASE(DNP)																						

		ITEM		QTY		REF DES		Var Status		MAXINV		MFG PART #		MANUFACTURER		VALUE		DESCRIPTION		STATUS				

		TOTAL		0																				



